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MS Word

Compatibility XE "Compatibility"  Issues

General Compatibility XE "Compatibility" : MS Office 95, 97, 2000, XP; MS Works

You’ll find different versions of Microsoft Office in the workplace, or on your own computer. In addition, lots of computers come with free MS Works installed, and since MS Office is so expensive, not everyone buys it. You would think that since they're both Microsoft products, they would be compatible, but alas, they aren't. 

1. You can save your work as a Word file (most versions of Works 
save as a .doc; Works docs end in .wps) or as an RTF file. (All word processing 
applications including works and Word Perfect allow this. RTF stand for rich 
text formatting and is kinda the lowest common denominator of word processing 
file types. It has some formatting but nowhere near as much as Word.)

2. You can install a conversion tool from Microsoft:
http://office.microsoft.com/downloads/2002/wp6rtf.aspx
 Go to this site, download the file, and install it. From here on you can read 
Works files in Word.

Basic Concepts

Using Shortcut Menus XE "Shortcut Menus"  (Word, PowerPoint, Excel)

Word, Excel, and PowerPoint all have Shortcut Menus XE "Shortcut Menus" . These menus appear when you click on any part of the screen with the right side of the mouse. Shortcut Menus contain commands related to the item you’ve pointed to. They save XE "save"  time, because you don’t have to search to find the command you want.

The Paragraph Mark XE "paragraph mark" 
In using Word, one basic concept that will save XE "save"  you a lot of grief down the line is that all the formatting of any paragraph is contained in the following paragraph mark XE "paragraph mark"  (to see all non-printing character, including hidden characters, press the paragraph mark in the toolbar, or td

Changing the Default Font XE "default font" 
1. Click Format
2. Click Font
3. Select the settings you want for every document

4. Click the Default button

5. Click the Yes button in the dialog box to confirm the change

6. Click OK
Changing Page Setup XE "Page Setup"  Default Settings

1. Click File
2. Click Page Setup XE "Page Setup" 
3. Change the settings for Margins XE "Margins" , Page Size XE "Page Size" , Orientation XE "Orientation" , or Paper Source XE "Paper Source"  to the settings you want

4. Click the Default button

5. Click the Yes button on the dialog box asking if you want to change the default settings for Page Setup XE "Page Setup" 
6. Click OK
Or....

1. Click Open in the File Menu

2. Choose Templates XE "Templates"  from the box on the bottom of the dialog box, then choose Normal template XE "Normal template" 
3. Make your changes and Save XE "Save"  the file

Creating a Document

1. In the File menu, click on New...
2. You’ll see a list of possible templates you can use... for now, choose Normal, which is the default. (More on templates in a separate manual.)

3. Type your document. Notice that you have wraparound text: your text formats itself and you need never type another carriage return again!  Actually, if you do press Enter out of habit, you will get into trouble when you change text.... so you will need to re-train yourself. The only time you use carriage return (now marked Enter) is when you want to force a carriage return, such as when you have come to the end of a paragraph. Type this paragraph or any part of it. Press Enter.

4. Now let’s do some fun things with the paragraph you just typed. 

· Highlight the first sentence.

· Go up to the font bar above and click on the arrow to the right. Scroll down to another font and click on it; look at your sentence now. Spend some time looking at all the fonts. 

· Now do the same thing with the Bold XE "Bold" , Italic XE "Italic" , and Underline XE "Underline"  buttons.

· Now take a look at the entire paragraph. Click 3 times quickly anywhere in the paragraph.  (Note: when you click within a word: one click moves the cursor to that location; two quick clicks highlights the word; and three quick clicks highlights the whole paragraph.)

· To select the whole document, click Ctrl+A; or choose Select All in Edit on the menu bar; or click anywhere in the left-hand margin while you’re pressing Ctrl.

· Click on the alignment XE "alignment"  buttons and see the difference between left alignment, centered, right alignment, and full justification XE "full justification" .

· Go to Page Setup XE "Page Setup" . Change the margins and look at your document. Type this list:

Item a

Item b

Item c.

· Highlight the list and press the numbers list button. 

· Do the same for the bullets XE "bullets"  button.

· You can move text XE "move text"  by selecting it (words, sentences, paragraphs), “grabbing” the selected text with your mouse and move it to a new location. You hold down the mouse button during the drag and release it when you reach its new home. (The cursor will be a left-pointing arrow.) Or… you can select text and choose Move in the Edit menu. Or… select text, Cut XE "Cut" , and paste into the new area by using the button or the command in the Edit menu. 

· You can copy text XE "copy text"  by dragging as above, while holding down the Cntl key. Or… use the Copy XE "Copy"  button and paste.

Saving a Document

To Save XE "save"  a Document

1. Select File, then Save in the Menu Bar. The first time you save a file, the Save As dialog box appears.

2. Type the name of the file. If you will be sharing this file with Word 6.0 users, the name needs to be 8 characters or less; otherwise it can be up to 255 characters.

3. When you save a document that has already been saved, Word uses the same file name and writes the data over the existing file. The Save As dialog box does not appear.

Where Does Your Word File Get Saved?

· If you open a file, it will be saved wherever it was when you first opened it. This could be the P: drive, A: drive (floppy disk), O: drive (if it came in the mail), or anywhere else.

· If it’s a new file, the default is to save XE "save"  it wherever it’s defined: Go to Tools, Options, File Locations XE "File Locations" . The default is to save documents in c:\My Documents, but you can change this.

Saving a Document with a Different Name (Saving a Copy XE "Copy" )

1. Select File in the Menu Bar, then Save XE "Save"  As..
2. Type in the new filename

3. Click OK
Saving and Backing Up Files XE "Backing Up Files" 
One of the most frustrating things that can happen to computer users is the loss of a file or data. This has been occurring a lot recently, probably because of the move. Construction, power outages, network moves, and high stress, are all hard on computers, computer users, and files. So here are a few suggestions.

· Back up files to a floppy disk. Whenever you complete anything, or whenever you get the chance, use Save As... in the File menu to save XE "save"  a backup file on a floppy disk. That way, whatever happens to your computer, the work you did is intact.

· Backup files to the network (when appropriate). If you have access to a network at work, you may be able to save your documents there. This is safer, because the network is backed up regularly, so if your computer dies for any reason they can get your document off the backup.

· Backup to your C drive as you work. Go to Save in the File menu, or use the Save icon on your toolbar to save your work regularly.

· Use the automatic save XE "automatic save"  options while using Word.
Word has several options to save documents, besides the normal Save and Save As... commands in the File menu.

1. Use Save All in the File menu. This will save all open Word files.

2. Use the keyboard Save commands. Typically these are Ctrl+S, Shift-F12, and Alt+Shift+F2.

3. Use the Save button on the toolbar. (It looks like a floppy disk.)

4. Set up optional Save features. Word will automatically create backup copies as you work, as well as automatically saving at intervals you specify. To set these options, follow these steps:

· Click on Tools on Menu bar

· Click on Options
· Click on Save tab

· Click on Always Create Backup Copy XE "Copy" . Every time you save, a backup file with the file extension .bak is created.

· Click on Automatic Save Every ____ Minutes. This option saves your document at the intervals you request. Just type in a number. This can be annoying when Word stops to save while you’re working, but you’ll appreciate it when the system crashes and you alone have a recovered document! Note: If you have clicked on Allow Fast Saves in the same menu, the automatic save XE "automatic save"  feature disables it, because an automatic save is a full save. The automatically saved files are temporary files, stored in the temp directory, and have an extension of .tmp. To recover, restart Word and go to the c:/temp directory.

Save XE "Save"  Save Save!

If you’ve heard it once, you’ve heard it a thousand times: YOU SHOULD GET IN THE HABIT OF SAVING YOUR WORK. So why don’t you save regularly? Maybe it’s because you need more specific instructions. So here they are. 

Save at the following times: 

· Before you answer the phone 

· Before you leave your desk 

· After you finish typing a paragraph or passage that finally reads the way you want it to 

· Before you print 

· Before you insert an object from another program—such as an Excel worksheet range—into the document 

· After you format lots of text 

· Before you create a table of contents 

· After you set up or format headers or footers 

· Before uninvited visitors to your office start bothering you with their problems 

· Whenever you realize you haven’t pressed Ctrl + S recently.

Moving Around in a Document

Using the mouse:

1. Click to move the I-beam XE "I-beam" , or insertion point, to a new location.

2. Use the scrollbar on the right to move up or down.

3. Use the scrollbar on the bottom to move right or left.

Note: Scrolling with the mouse doesn’t move the insertion point. You have to point and click to move it.

Using the Keyboard

	To Move to the…
	Press…

	Next character
	(

	Previous character
	(

	Next Word
	Control key and ( 

	Previous word
	Control key and ( 

	Line above
	(

	Line below
	(

	Paragraph above
	Control key and (

	Paragraph below
	Control key and (

	Beginning of line
	Home key

	End of line
	End key

	Top of window
	Control key and Page Up key

	Bottom of window
	Control key and Page down key

	Next Screen
	Page Down key

	Previous screen
	Page Up key

	Beginning of document
	Control key and Home 

	End of document
	Control key and End


Changing a Document

You have Choices!

All of the Windows applications give you multiple methods to do just about anything.

· You can use the Pull-down menus XE "Pull-down menus"  at the top of your screen. Take time to look at each one and see which commands are included in each menu.

· You can use toolbars XE "toolbars" , located under the Menus and above your work area. To choose the toolbars you want to see, click View and Toolbars. Check the ones you want. Click Customize XE "Customize"  if you want to add buttons that aren’t part of the normal toolbars; in the Customize dialog box, just drag a button up into the toolbar. Or you can drag a button you don’t want off the toolbar and onto the Customize dialog box to get rid of it.

· You can use keyboard commands. You can see what they are by looking in the drop-down menus.

· Any time you see a menu list showing a command with one letter underlined, typing the underlined letter will invoke that command.

· If you can’t use your keyboard, you can get a drop-down menu by pressing Alt plus the underlined letter you see in the Menu bar (i.e. F for File.)

Selecting Text XE "Selecting Text" 
Selecting Text with the Mouse

	To Select this…
	Do this…

	One word
	Double-click on the word

	A sentence
	Press the Control key and insert the I-beam XE "I-beam"  anywhere in the sentence

	A line
	Position the cursor in the left margin so that the cursor become a right-pointing arrow, and click

	A paragraph
	Position the cursor in the left margin so that the cursor becomes a right-pointing arrow, and double-click

Or…

Triple click anywhere in a paragraph

	A whole bunch of text
	Place the cursor at the beginning of the text, hold down Shift, and click at the end of what you want to select.

Or…

Place the cursor at the beginning of the text you want to select, and while holding down the Shift key, use the arrow keys to expand the selection.

	An entire document
	Hold down Ctrl-Shift and click in the left margin of the document.

Or…

Press Control+A
Or…

Choose Select All from the Edit menu

Or…

Place the cursor at the very beginning of the document and press Ctrl-Shift-End.

	A specific area
	Position the insertion point to the left of the text to be selected, click, and drag to the end of the text to be selected

Or….

Click at the beginning of the area to be selected, press the Shift key, and click on the end of the text to be selected

	Text without regard to words or paragraphs
	Use Alt+mouse and select


Un-Selecting Text

Click anywhere. Also, if you make another selection, the previous one will be canceled.

Keys to Making Basic Changes

· To insert text, point and click in the location you want the new text and type it in. Word is in the Insert mode XE "Insert mode"  by default.

· To type over existing text, press the Insert key and type in the new text. The status bar displays the message OVR XE "OVR"  to tell you you’re in the Overtype mode. Press Insert a second time to return to the Insert mode XE "Insert mode" .

· To delete text, select the text and press the Delete key XE "Delete key" . If no text is selected, pressing Delete deletes one character to the right of the cursor. Pressing the Backspace key deletes one character to the left of the cursor.

· If you highlight a section of text and type, Word deletes the highlighted text automatically and types over it.

· To turn off Typing Replaces Selection XE "Typing Replaces Selection" : 

1. Choose Tools + Options to open the Options dialog box. 

2. Click the Edit tab. 

3. Under Editing Options, deselect Typing Replaces Selection. 

4. Click OK
Basic Editing Features

1. Highlight the first sentence.

2. Go to the Font box in the formatting Toolbar and click on the arrow to the right. Click on another font; try out a few.

3. Go to the font size list and try different font sizes. Remember that one point = 1/72 of an inch, so there are 72 pints in an inch. The larger the number, the larger the font. A font size under 10 is likely to be hard to read by most people; over 14 looks more like a headline.

4. Try the Bold XE "Bold" , Italic XE "Italic" , and Underline XE "Underline"  buttons.

5. Click 3 times quickly anywhere in a paragraph to select it. Click on the alignment XE "alignment"  buttons and see the difference between left alignment, centered, right alignment, and full justification XE "full justification" .

6. Go to Page Setup XE "Page Setup" . Change the Margins XE "Margins" . Change the Orientation XE "Orientation"  to Landscape XE "Landscape" .

7. Type this list:

Item a

Item b

Item c

8. Highlight the list and click on the Numbering XE "Numbering"  list button.

9. Click on the Bullets list button XE "Bullets list button" .

Correcting Simple Typing Mistakes

	To do this…
	Do this…

	To delete XE "delete"  a character
	Press Backspace or Delete key (Backspace deletes back one space, while Delete deletes one space forward.)

	To insert text
	Move the insertion point where you want the text, and type.

	To delete a block of text
	Select the text, then press Delete.

	To replace text
	Select the text you want to replace, then type the new text

Or…

Press the Insert Key to turn on the Overtype mode. Now you will type over the existing text, and you’ll see OVR in the status line.


Line Spacing XE "Line Spacing" 
Changing line Spacing

1. Select Format in the Menu bar, then Paragraph
2. Select the Indents and Spacing tab

3. Select the Line Spacing option you want (see below) and click OK 

Line Spacing Options

· Single XE "Single" : accommodates the largest font in that line.

· 1.5 Lines: Sets the line spacing to one and a half times that of single line spacing.

· Double XE "Double" : There is a full line of spacing between lines.

· At Least XE "At Least" : sets a minimum line spacing that Word can adjust to accommodate larger font sizes.

· Exactly XE "Exactly" : sets a fixed line spacing that Word does not adjust.

· Multiple XE "Multiple" : allows line spacing to be increased or decreased or decreased by any percentage.

· Use the At box option to type the line spacing you want if you’ve chosen At Least, Exactly, or Multiple.

Paragraph Spacing XE "Paragraph Spacing" 
Paragraph Spacing is setting the space between paragraphs. Options include setting the spacing before the current paragraph and setting the spacing after the current paragraph.

To Change paragraph spacing for the current paragraph or selected paragraphs:

1. Select Format in the Menu bar, then Paragraph
2. Select the Indents and Spacing tab

3. Change the values in the Before and/or After boxes and click OK
Un-Selecting Text XE "Un-Selecting Text" 
Suppose that you selected some text—for formatting, deleting, replacing, moving, copying, whatever. You’re about to do whatever it is you want to do when suddenly, for no reason, you decide you don’t want to do it. How can you unselect this text? It’s easy—but in this case, what you DON’T do is as important as what you DO do: 

1. DON’T type. By default, Word replaces selected text with whatever you type (next time, we show you how to cancel that default, if you wish). 

2. DO click anywhere else on the page. Doing so immediately unselects any selected text.

Using Cut XE "Cut" , Copy XE "Copy"  and Paste XE "Paste" 
You can cut, copy or paste text, by highlighting and telling Word what to do with it. Cut XE "Cut"  means to remove an item from the document and put it on the windows clipboard for further use (as opposed to delete or clear, which remove the item forever… unless you Undo.) Copy XE "Copy"  puts the items on the clipboard as well, but also leaves it where it was. Paste XE "Paste"  takes whatever is in the clipboard and puts it where the insertion point is. (You can only put one item at a time on the clipboard; it will remain there until you put something else there or until you shut down Windows, whichever comes first.)

Copying Text

Using the Menu Bar:

1. Select the text to copy

2. Select Edit, then Copy
3. Move the insertion pit to the place you want the text

4. Select Edit, then Paste
Using the toolbar:

1. Select the text to copy

2. Click on the Copy button

3. Move the insertion point to the place you want the text

4. Click on the Paste button

5. Copying text places the selection on the Clipboard, no matter which method you use. It stays there until you put something else there or exit Windows, whether or not you Paste it somewhere.

Using the drag and drop method:

1. Select the text to copy

2. Point to the selected text (The mouse pointer changes to an arrow.)

3. Hold down the Control key and drag the selection it its destination.

4. Release the mouse button, then the Control key. 

Moving Text

To move text XE "move text"  using the menu bar or buttons:

1. Select the text to move

2. Select Edit, then Cut; or press the Cut button.

3. Move the insertion point to the pace you want the text

4. Select Edit, then Paste; or press the Paste button.

Note:  Cutting text, like copying text, places the selection on the Clipboard, where it will remain until you cut or copy another selection, or close Windows.

To move text using the Drag-and-Drop XE "Drag-and-Drop"  Method:

1. Select the text to move

2. Point to the selected text; the mouse pointer changes to a while arrow.

3. Drag the selection to the destination

4. Release the mouse button

Enabling or Disabling the Drag-and-Drop XE "Drag-and-Drop"  Feature

1. Select Tools in the Menu bar

2. Click Options
3. Click on the Edit tab

4. Enable/disable Drag and Drop Text Edit and click OK
Undo XE "Undo" 
All of us have had the awful experience of realizing that we just did something totally stupid. Not to worry! Word has several ways to remedy just about anything.

· Press the Undo button on the Toolbar. This will undo the last action you took.

· Click the down arrow next to the Undo button. This will show you the last 100 actions. If you click any action in the middle, though, you will also undo all the other actions to the present.

· Click the Undo command in the Edit Menu XE "Edit Menu" . It will say Undo Clear, or Undo Typing, or whatever your last action was.

· You can also close your document without saving. This means you go back to the document at the time you last saved it. 

Using Find and Replace XE "Find and Replace" 
This feature is particularly useful when you want to make global replacement: for example, if the company changed names, you’d want to change the name in every place it appears in the document. Here’s how:

1. Click on Find in the Edit menu.

2. In the Find What box, type the word or phrase you’re looking for.

3. Click on the Replace tab.

4. Type the new text you want in the Replace With space.

5. Click Replace All.

Checking Your Work

Spell checking XE "Spell checking" 
You’ll get a wavy red line under any words Word thinks are misspelled, and a wavy green line under those words or phrases word deems to be incorrect or awkward. I, of course, never misspell, but my typing is awful, and I need Word to catch a lot of garbage! In addition to spelling errors, the spell checker will catch double words (the the), oddly capitalized words (mY), words that should be capitalized (california), and words that should be all capitals (DOS).

To turn these features on or off:

1. Click Tools in the Menu bar

2. Click Options
3. Select the Spelling tab

4. Check or un-check the Check Spelling as You Type and Check Grammar as You Type boxes.

To correct underlined spelling errors XE "correct underlined spelling errors" : 

1. Double-click the open book icon in the status bar at the bottom of the screen to find the next underlined word in the document. Or right-click an underlined word. A pop-up menu appears with a list of suggested words and additional options.

2. You have four choices to correct the word:

· Correct the word if it’s misspelled.

· Select a word from the list in the pop-up menu.

· Select Ignore All to do nothing.

· Select Add to add the word to the selected dictionary displayed in the Custom dictionary in the Spelling dialog box.

Note: You can also add the entry to AutoCorrect so that in the future that particular spelling error will be corrected automatically. (See below.)

If you’ve turned off the automatic spell check feature, you can use the spell checker as you used to with Word 6.0: simply click the Spelling button, or go to Tools in the Menu bar and click Spelling & Grammar…
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Using AutoCorrect XE "AutoCorrect" 
Every typist has typing mistakes that they make just about every time. Word’s AutoCorrect feature recognizes common mistakes and fixes them automatically. The system by default has a list of words it will correct. To see this list, click Tools in the Menu bar, then AutoCorrect…

Notice that AutoCorrect also corrects two initial capitals, etc.

To add a new AutoCorrect item:

1. Choose Tools, AutoCorrect. Word displays the AutoCorrect dialog box. Select the AutoCorrect tab if it’s not selected.

2. In the Replace text box, type the misspelling or abbreviation you want to have corrected automatically. 

3. In the With text box, type the correct spelling of the word or phrase. (Or.. you can select a long phrase in the document before opening AutoCorrect, and it will already be in the With text box.)

4. Click Add to add the new entry to the list. If an entry is already there, the Add button will say Replace, and Word will ask you if you want to replace.

5. Click OK.

Note: there can be only 255 or fewer characters in an AutoCorrect entry. If you need more, you need to use AutoText. (See below.) 

Also note… you can use AutoCorrect to quickly correct any phrase or word that is cumbersome. For instance, you could add an entry to tell Word to substitute Navigation Technologies every time you type a code, such as navtec.

Adding AutoCorrect XE "AutoCorrect"  Entries during a Spelling Check

When you right-click a misspelled word, one of your options is AutoCorrect XE "AutoCorrect" . If you move your mouse over it, you may see suggested spellings. You can click one from this location, and it will not only correct the word, but also add it to your AutoCorrect list. Note:  if there are no suggestions, you can’t add an entry from here. Also, if you’ve already got an entry for the misspelled word, you’ll be asked if you want to redefine it.

Creating a Special Dictionary XE "Dictionary" 
If you write a large number of documents that call for numerous technical terms, you’ll find it handy to create a special dictionary for that purpose. To create a dictionary, open a new Word document and type the words you want to enter in a single column. Your entries should appear in a list like the one in this sample: 

RMS 

Voltage 

Ohm 

Ohm's 

Ampere 

Current 

RAM 

ROM 

EEPROM 

Disk 

Disc 

After you’ve added all the words you need at the moment (you can add more later), choose File, Save As and type in Special.dic. Now click the arrow at the right of the Save as Type list box to expand it.  Select Text Only (*.txt) and then locate the folder c:\Program Files\Common Files\Microsoft Shared\Proof and click Save. 

The location can vary, depending on the Windows version and the Office version you use, and on your own installation. You may find that you need to save to the folder named c:\windows\msapps\proof. 

When Word asks about saving a text file, tell it to go ahead. When you close the document (or close Word) you’ll be asked about saving a nonstandard file again. Once again, tell Word to go ahead and save the text file. 

Now, back in Word, choose Tools, Options and click the Spelling tab.  Click Custom Dictionaries. If your new dictionary appears in the list, select it and click OK. If it doesn’t appear in the list, click Add. Your new dictionary should appear in this dialog box. Select it and click OK. Now locate it in the list and select it. Click OK to add the dictionary and close the dialog box. 

Grammar Check XE "Grammar Check"  and Readability Statistics XE "Readability Statistics" 
Word allows you to check you grammar, as well as your spelling. It dislikes passive verbs, gender-specific items, and long, complicated sentences. It will offer corrections if it thinks of any.

Grammar

As you type, Word will normally put a red line under any spelling errors and a green line under grammar errors. You can right-click either to see possible solutions, or ignore the error.

To manually check grammar, go to Tools, Spelling and Grammar XE "Spelling and Grammar" . You’ll see this dialog box. Make sure the box next to the word Grammar is checked. As Word finds a grammatical error, the assistant will tell you what the rule is for this error.

Selecting Grammar Rules

You can choose the rules of style and grammar that Word uses. Choose Tools, Options and select the Spelling & Grammar tab. (If Grammar is grayed out, it wasn’t loaded when your Office system was installed. Contact the Help Desk.) You can choose Casual, Standard, Formal, Technical, or Custom. (Standard is the default.)

Readability

Readability statistics measure how easy your writing is to read. For examples, The Wall Street Journal writes at the eighth grade level, and Hemingway wrote at the sixth-grade level. To see these statistics, do this:

1. Choose Tools, Options.

2. Select the Spelling & Grammar tab.

3. Select the Show Readability Statistics check box.

4. Choose OK.

Note: the statistics are based on the Flesch-Kincaid XE "Flesch-Kincaid"  index, which assigns a reading ease score and grade level based on the average number of words per sentence and syllables per 100 words.

Using the Thesaurus XE "Thesaurus" 
You can look up a word in Word’s thesaurus either by selecting a word or by making sure the insertion point is within the word for which you want a synonym. Then choose Tools, Language XE "Language" , Thesaurus. You’ll see this dialog box:
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Double-click any word you want to use in place of the selected word, or press cancel to choose none of the above.

Proofing in Other Languages

If you want to proof in another language, you have to buy and install proofreading tools for that language. Then choose the language in Tools, Language XE "Language" , Set Language.

Counting Words XE "Counting Words" 
Choose Tools, Word Count. The Word Count dialog box appears. Include footnotes and endnotes if you want those words included. Choose Close when you’re done.

Viewing Your Documents: Normal, Outline XE "Outline" , and Page Layout View XE "Page Layout View" 
In the View menu, you can choose to look at your document in Normal, Page Layout, or Outline XE "Outline"  view.

· Normal view XE "Normal view" : most efficient, lets you concentrate on typing because you can’t see formatting. You won’t see page numbers, headers, margins etc. However, you will see hard page and section breaks and can delete them from this view. Also allows you to see all the styles if you’re using styles. However, if you can’t see them in the left margin, you need to change the margin. Do this:

1. Go to Tools
2. Click Options
3. Click View
4. Find the box at the bottom that says Style area width XE "Style area width" ; make sure it is greater than 0”. Once it’s visible, you can drag it to where you want it anytime in Normal or Outline View.

5. Click OK.

· Page Layout: Looks more or less as you finished document will appear. Shows headers, footers, margins etc. However, you can’t see the styles nor change the style area width.

· Outline: Very similar to Normal, except it set up a hierarchical outline for the document. Not very useful if you don’t use styles, but if you’re creating long documents, using styles and advanced templates, or want a quick and easy way to move large chunks of text around, this is the way to do it. You can change the style area width from here as well, using the procedure above.

Formatting XE "Formatting" 
Text Flow XE "Text Flow" 
Text flow lets you keep text together, and avoids splitting lines with a soft page break, which is a page break generated automatically by Word. (A hard page break is one you insert manually using the Break command in the Insert menu.)

To set text flow options:

1. Select Format in the Menu bar, then Paragraph.

2. Select the Text Flow tab.

3. Set the choices you want.

4. Click OK.

Below are the text flow options and what each does:

· Widow/Orphan Control XE "Widow/Orphan Control"  ( prevents Word from printing the last line of a paragraph by itself at the top of a page (widow) or the first line of a paragraph by itself at the bottom of a page (orphan).

· Keep lines together XE "Keep lines together"  ( prevents a page break within a paragraph.

· Keep with Next XE "Keep with Next"  ( prevents a page break between a paragraph and the following paragraph.

· Page Break Before XE "Page Break Before"  ( inserts a page break before a paragraph.

Formatting Characters

Font Options XE "Font Options" 
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To format specific characters, you can use either the formatting Menu bar (usually up by default; if not, go to View, Toolbars, and choose it), or Format, Fonts. You’ll get this dialog box:

You can choose from these options:

Font: describes the style you can use. You’ll have a large number of styles to choose from, and you can add more in the Windows Control Panel if you want. Keep in mind, though, that your printer may not be able to print all fonts, and also if you send a document electronically to someone who doesn’t have that font, the effects they get may not be what you want. 

Font types are essentially serif XE "serif"  or sans serif XE "sans serif" . Serif fonts have “wings (ABC) and sans serif are “without wings” (ABC). Serif fonts tend to be easier to read, and sans serif fonts tend to be more decorative.

Font Style: there are four basic font styles: Regular, Italic XE "Italic" , bold, and Bold XE "Bold"  Italic.

Size: you can use font sizes up to 1638 points XE "points" —or 136.5 inches (Word 97). Practically speaking, you’ll use 10 and 12 for most documents, with larger sizes for headers and smaller sizes for notes, footnotes, etc. One inch = 72 points; one point = 1/72 of an inch.

Underline XE "Underline" : you can choose none, single (underlines the space between words), Words only (doesn’t underline the space between words), Double, dotted, Thick, Dash, Dot dash, Dot Dot Dash, Wave. (Note: only the first four items are available in Word 95 and 6.0.) 

Color: choose among a list of font colors.

Effects XE "Effects" : strikethrough, Double Strikethrough, Superscript, Subscript, Shadow, outline, Emboss, engrave, Small caps, All caps, Hidden (text doesn’t appear or print; used for private comments.)

Default: Applies selected formatting to the template attached to the document, as well as to the current document.

Preview XE "Preview" : shows a sample of text formatted with the option selected.

Character Spacing Options XE "Character Spacing Options" 
	Group
	Option
	Description

	Spacing
	Normal

Expanded

Condensed
	Default spacing for the selected font

Space between characters 3 points

Space between characters 1.75 points

	By:
	1 pt. (default), or enter
	Number of points by which text is expanded or condensed. Measures in tenths of a point.

	Position
	Normal

Raised

Lowered
	Text is printed on the base line

Text is raised above the baseline by the increment you indicate in By

	By
	3 pt. Default, or enter your own
	Number of points text is raised or lowered

	Kerning for Fonts
	8 pt. default or enter your own
	No. of points by which specific characters are spaced: only used for True Type or Adobe Type Manager fonts

	Default
	
	Applies selected formatting to the template attached to the document, as well as to the current document. All future documents based on this template will use the selections in the font dialog box as the default font XE "default font" .

	Preview XE "Preview" 
	
	Shows how the selected text would look


Switching Case

1. Select the text you want to change.

2. Choose Format, Change Case XE "Change Case" .

3. Choose one of these:

· Sentence case makes only first character of the sentence uppercase

· Lowercase: all lowercase

· UPPERCASE: All uppercase

· Title case: first character of each word to uppercase

· tOGGLE cASE: Switches upper to lower and vice versa.

4. Click OK.

Superscripts XE "Superscripts"  and subscripts XE "subscripts" 
To add or remove superscripts or subscripts, do this:

1. Select the text you want to raise or lower, or position the insertion point where you want raised or lowered text to begin.

2. Choose Format, Font.

3. Select the Font tab.

4. In the Effects group, select Superscript to raise text, or Subscript to lower it. 

5. Choose OK.

By default, Word raises superscript 3 points (3/72 of an inch) above the baseline and lowers subscript 3 points below the baseline. You can change this by using the character spacing tab: 

1. Choose Format, Font. Select the Character Spacing tab.

2. Choose Raised or Lowered from the Position box.

3. Click the up or down arrows to change. 

4. Click OK
Drop Caps XE "Drop Caps" 
D

rop caps can enhance a document’s appearance without looking gaudy. To use this feature, place the cursor in the sentence where you want to apply the drop cap. Choose Format, Drop Cap. For now, just click Dropped and OK. 

If you’d like to change the appearance of your drop cap, click in the sentence again and choose Format, Drop Cap. This time, adjust the number of lines to see how it looks—make it two lines instead of three, for example, and click OK. 

Set the drop cap to two, and try three or four. Experiment and see what looks best in your document. If you tell it to drop only one line, the drop cap will disappear. 

You can also choose a different font, or change the amount of space before the text.

If you want to get rid of a drop cap, you can click the sentence and choose Format, Drop Cap. When the dialog box opens, click None and then OK.

Animation Effects XE "Animation Effects"  (Word 97 Only)

	Group
	Option
	Description

	Animations
	(none)
	Normal. Use to remove animation.

	
	Blinking XE "Blinking"  Background XE "Background" 
	Text blinks between normal and inverse video.

	
	Las Vegas Lights
	Box around selected text changes between several patterns and colors.

	
	Marching Black Ants
	Black dash-lined box around selected text appears to move in a clockwise rotation.

	
	Marching Red Ants
	Red dash-lined box around selected text appears to move in a clockwise rotation.

	
	Shimmer XE "Shimmer" 
	Text changes between normal and a distorted view.

	Preview XE "Preview" 
	
	Shows a sample of text formatted with selected option


Changing Orientation XE "Orientation"  with Text Direction XE "Direction:Text"  (Word 97 Only)

You can change text direction within a table cell, text box, or frame. 

1. Select the text to be changed

2. Choose Format, Text Direction. The Text Direction dialog box appears. In the Orientation XE "Orientation"  group, select the orientation XE "orientation"  you want. 
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3. Click OK.

Formatting Paragraphs

You can easily change a paragraph’s formatting by putting the insertion point anywhere in the paragraph and using buttons, keyboard commands or menu commands.

Displaying Paragraph Marks

Remember, Word stores paragraph formatting in the paragraph mark XE "paragraph mark" , which means if you accidentally delete a paragraph mark you could lose your formatting. For that reason, if you do a lot of text editing you’ll probably want to see your paragraph marks. To display them, you can use the Show/Hide button XE "Show/Hide button"  on the toolbar. (Click Tools, Options, View and check All to be able to view all the hidden characters.)

Note: To enter a new line without starting a new paragraph, so that your formatting will continue to apply, press Shift and Enter.

Aligning Paragraphs

You can choose left justification; right, typically used for money or columns of figures; center, commonly used for titles or decorative text; or full justification XE "full justification" . Full justification looks prettier from a distance, but is less easy to read because it stretches words to fill the line, so you have fewer visual clues than if you left-justified. 

Indents XE "Indents" 
Indenting allows a paragraph or part of a paragraph to be set in from the main body of text. Options are:
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Left – determines where each line of the paragraph begins in relation to the left margin

· Right – determines where each line of the paragraph ends in relation to the right margin.

· Hanging – determines how far to the left of the left indent the first line will start.

· First Line – determines how far to the right of the left indent the first line will start.

To set indents for the current paragraph:

1. Select Format from the Menu bar, then Paragraph.

2. Select the Indents and Spacing tab.

3. Set the choices you want for left and right indents.

4. Click on the drop-down arrow in the Special text box to select First Line or Hanging indent and set the size for the indent.

5. Click OK.

6. You can set the left indent to the next tab stop by clicking on the Increase Indent button. You can also decrease the left indent (“outdent”) by one tab stop by clicking on the Decrease Indent button on the formatting toolbar.

Borders XE "Borders"  and Shading XE "Shading" 
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You can put various kinds of borders and shading around any paragraph, or one or more characters. When you do, all the other formatting will stay the same. Click Format, Borders and Shading… to get the dialog box.

Borders

Options for Borders. Items marked 97 are only available in Word 97.

	Option
	Effect

	None
	No box. Use to remove an existing box.

	Box
	A box with identical lines on all four sides

	Shadow
	A box with a drop shadow on the bottom right corner.

	3-D XE "3-D"  (97)
	A “picture frame” box. You must select an asymmetric line style for this to work. 

	Custom (97)
	Custom design borders on one or more sides of the selected paragraph using Preview XE "Preview"  buttons.

	Preview XE "Preview"  (97)
	A line on one or more sides of the selected paragraphs(s). Dotted lines at the corners and sides of the sample indicate where the lines appear; when they are selected, arrows point to these dotted lines.

	From Text
	(Select the Options button.) The distance between the line or box and the text, measured in points. Because 72 points make up an inch, select 9 points for a .125” distance or 198 points for a .25” distance.

	Style
	A line or box in the selected line style. Options listed show exact point size and a sample display.

	Color
	A line or box in the selected color. 16 colors and grays shades are available.

	Width (97)
	A line or box in the selected width.


Page Borders

Use this tab to create a border for an entire page.

Using the Borders and Shading Toolbar
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Click View, toolbars XE "toolbars" , Borders and Shading to get this toolbar.
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Shading

Paragraphs can be shaded, in various percentages of black or a selected color, and in patterns. You can choose a foreground or background color. 

Patterns give you much more dramatic effects:

	Shading Option
	Effect

	Fill
	A background color for the selected shading pattern. Auto selects the best color, usually white. Select from 16 colors.

	None
	No shading in selected paragraphs(s).

	Custom
	Shading in the selected custom shading; Options are listed below.

	Style
	Shading in the selected custom darkness or pattern. Options include increasing degrees of shading and various patterns. Clear applies the selected background color. Solid applies the selected foreground color.

	Color
	A foreground color for the selected shading pattern. Auto selects the best color, usually black. You can select from 16 colors, including black and white.


To shade paragraphs, do this:

1. Select the paragraph, table cell, or frame to shade.

2. Click Format, Borders and Shading XE "Borders and Shading" . 

3. Click the Shading Tab.

4. Select the Style pattern you want. Options include Clear (uses the background color), Solid (uses the foreground color), percentages, and striped and checkered patters such as Dk Horizontal (for dark horizontal stripes) and Lt Grid (for a grid make of light cross-hatching.)

5. Select a color from the Color list or color a percentage pattern or a pattern foreground.

6. Select a color from the Fill list to color a percentage pattern or a pattern backgrounds.

7. Click OK.

To remove shading XE "shading:removing"  using the menu command, do this:

1. Select the paragraph or paragraphs from which you want to remove shading.

2. Choose format, Borders and Shading.

3. Click the Shading button.

4. Choose None from the Fill group.

5. Click OK. 

Tab Stops XE "Tab Stops" : Menu

Word uses default tab setting of tab stops at every 0.5”. Setting tab stops involves choosing the type of tab(left, centered, right, decimal, or bar(and specifying where they should go. Then you use the tab key to move the insertion point as you’re typing. You can also add leader styles XE "leader styles" , including dotted, dashed, or solid.

To set tabs, you can use either the Tabs dialog box or from the Ruler XE "Ruler" . To be sure you can see your tabs as you’re creating, go to Tools, Options, View tab, and turn Tab characters on in the Nonprinting characters XE "Nonprinting characters"  group.
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Tabs belong to paragraphs. If you set tab stops as you type and then press Enter, the tab settings apply to the next paragraphs you type. If you add tabs later, they’ll only apply to the stuff you selected when you set them. 

Using the Tabs Dialog Box XE "Tabs Dialog Box" 
1. Select the paragraph or paragraphs for which you want to sets tabs, or position the insertion point where you want the tab settings to begin.

2. Choose Format, Tabs. The Tabs dialog box appears.

3. Using decimal numbers, type the position of the tab stop you want to set in the Tab Stop Position XE "Tab Stop Position"  box.

4. From the Alignment group, select the tab style you want: Left, Center, Right, Decimal, or Bar.

5. In the Leader group, select the tab leader style you want, if any. 1 is no leader, 2 is dotted line, 3 is dashed, and 4 is underlined.

6. Click Set.

7. Repeat steps 3-6 for more tab stops.

8. Click OK. 

Clearing Tab Stops XE "Tab Stops" 
Select the paragraph or paragraphs from which you want to clear tabs, or position the insertion point where you want to begin working with the new tab settings.

1. Choose Format, Tabs
2. Click the Clear All button

3. Click OK
Tab Stops XE "Tab Stops" : Ruler XE "Ruler" 
To see the ruler, click View, Ruler XE "Ruler" . This method is quicker but does not let you use bar tabs. You must select the tab style by clicking the Tab Alignment button on the ruler, and then set tabs where you want them on the ruler.

By default, tabs are set every 0.5”. If you change one, all the default tab stops to the left are removed. Click on the button to choose the type of tab you want, then click on the ruler to insert it. To remove, grab a tab and pull it off onto the document. Double-click a tab stop to open the Tabs dialog box (as above), so you can use Tab Leaders or change the stop’s alignment XE "alignment" .
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Using Format Painter XE "Format Painter"  to Copy Formatting

1. Select the text containing the formatting you want to duplicate.

2. Click the Format Painter button.

3. Drag across the text you want formatted.

When the Formatting XE "Formatting"  Boxes are Blank

You select some text and, as is your habit, turn to the trusty Formatting toolbar for a quick update on the fonts, text sizes, attributes, alignment, and other formatting currently applied to that text. 

But what’s this? The Style, Font, and Font Size boxes are empty! And the Bold button is not turned on, even though you can plainly see bold text in the selection. What’s going on? Calm down, and remember the following rule: When the contents of the Formatting toolbar seem to disappear—or not to work—it means that you’ve applied different formats to different parts of the selected text. If the selected text includes text in two or more fonts, the Font box displays nothing (rather than choosing just one of the fonts and risking misleading you). If the selected text includes text that is both bold and not bold, the Bold button remains unpressed (so you won’t think plain text is bold). Nothing is wrong with your display.

Analyzing the Formatting XE "Analyzing the Formatting" 
Suppose you see a paragraph whose formatting you love. There’s only one problem: You can’t figure out how it got that way. Here’s one way to find out: 

1. Choose Help + What’s This? 

Click in the paragraph. 

A box appears, describing the formatting applied to both the specific character you clicked and the paragraph that contains it. Even better, you can keep clicking other paragraphs and characters to find out more about them; just press Esc when you have enough information.

Numbered and Bulleted Lists XE "Numbered and Bulleted Lists" 
A bulleted or numbered list is a special type of list formatted with a hanging indent. (A hanging indent is when the paragraph’s for line goes all the way to the left margin, but all other lines in the paragraph are indented, or “hanging” off the first line. Bulleted lists have a bullet at the left margin, while numbered lists have a number and are numbered sequentially.

You can type the text for the bulleted or numbered list and then apply the list formatting. Or, you can place the insertion point in a blank line, apply the bulleted or numbered list format to that line, and type the list. Either way, after you select a bulleted or numbered list format, Word sets a ¼ inch hanging indent and adds the bullets XE "bullets"  or numbers in front of each paragraph in the selected text, or adds them to each new paragraph you type.

The bulleted or numbered list format carries forward from paragraph to paragraph. Each time you press Enter to begin a new paragraph, Word adds a new bulleted or numbered paragraph. You can add another bulleted or numbered item anywhere in a list by placing the insertion point where you want to add the new item and pressing Enter. 

Creating a Bulleted List XE "Bulleted List" 
1. Type a list at the left margin, without using Tab. Select the list, or place the insertion point on a blank line.

2. Choose Format, Bullets and Numbering XE "Numbering" . The Bullets and Numbering dialog box appears:

3. Click the Bulleted tab to see the bullet options.

4. Select the bulleted list format you want, or click Customize XE "Customize"  for more bullets.

5. Click OK. Word formats the current line, or selected text, as a bulleted list.

Using the Bullets Toolbar

This method is quicker, but gives you fewer choices. If you use the Bullets button, word uses the last bullet option you used.

1. Choose View, Toolbars and select Formatting, if the Formatting toolbar is not already displayed. 

2. Type a list and select it.

3. Choose the bullets button.

Numbering XE "Numbering" 
1. Type a list at the left margin, without using Tab. Select the list, or place the insertion point on a blank line.

2. Choose Format, Bullets and Numbering. The Bullets and Numbering dialog box appears:

3. Click the Numbering tab to see the Number options.

4. Select the format you want, or click Customize XE "Customize"  for more choices.

5. Click OK. Word formats the current line, or selected text, as a numbered list.

Using the Numbered Toolbar

This method is quicker, but gives you fewer choices. If you use the Numbers button, word uses the last number option you used.

1. Choose View, Toolbars and select Formatting, if the Formatting toolbar is not already displayed. 

2. Type a list and select it.

3. Choose the numbers button.

Ending a Bulleted or Numbered List XE "Ending a Bulleted or Numbered List" 
1. Press Enter to add a bulleted or numbered, blank line to the end of the list.

2. Move the pointer over the blank line and click the right mouse button. Word moves the insertion point to that line and displays a context-sensitive menu.

3. Choose Bullets and Numbering.

4. Choose the appropriate tab and click None. Word removes the bullet or number and hanging indent from the blank line.

Or…

If you press Enter twice, Word 97 figures out you’re done and removes the bullets or numbers from the last 2 items.

Creating A Fancy Bulleted List XE "Bulleted List"  on the Fly 

Want to add a little pizzazz to your list text—but without a lot of fuss?  You can take advantage of a little-known aspect of Word’s autobullet XE "autobullet"  feature and quickly generate bullets from the symbol fonts you have installed on your machine. First, you need to make sure the autobullet feature is activated. To do this, choose AutoCorrect XE "AutoCorrect" ... from the Tools menu and click the AutoFormat as You Type tab. Then, select the Automatic Bulleted Lists XE "Bulleted Lists"  check box in the Apply as You Type panel (if it’s not selected) and click OK. 

To create a bulleted list, start by choosing Symbol XE "Symbol" ... from the Insert menu, selecting the desired font from the Font dropdown list, and clicking on the character you want to use as your bullet. Next, click Insert and then click Close to return to your document. Now, enter two spaces, type the first list item, and press Enter to begin another line. Word will insert your symbol at the beginning of the new line. Just enter the second item and press Enter to create the third line. Repeat the process of typing items and pressing Enter until your list is complete. Finally, press Enter twice to “turn off” your bullets XE "bullets" .

Making A Blank Line XE "Blank Line"  in a List

When you choose to use bullets XE "bullets"  or numbering in a Word document the new number or bullet appears when you press Enter. If you’d like to insert a blank line between one bulleted line and another, you can press Shift-Enter. To get to the next bulleted line, press Enter.  This produces the effect shown here. 

1. Line one 

2. Line two 

3. Line three 


4. Line four 

5. Line five

Page Setup XE "Page Setup" 
Margins XE "Margins" 
The margins of a page are the blank spaces on all for sides of a page. They may contain headers, footers, page numbers, footnotes, or even text and graphics, but are not part of the body of the document.

Word’s default values are 1 inch at the top and bottom and 1.25 inches on the left and right. You can change the margins for the entire document or for parts of the document, if you divide the document into sections. Different views in Word show different perspectives. In Normal and Online Layout XE "Online Layout"  view, you don’t see the margins, but you see the space between them. In Page Layout view, you see the page as it will print, margins and all. To select a view choose View, then choose Normal, Online Layout, or Page Layout. You can also click the icon at the lower left-hand corner of the window.

Changing Margins XE "Margins" 
Choose File, Page Setup XE "Page Setup" . You can either type in the boxes, or click the up or down arrows to change the margins. You must have some margins, because the printer needs space as well. Typically you don’t want to get smaller than .3”. Word can usually figure out that your settings are too small for the printer you use and will tell you to fix them.

If you check Mirror Margins, Word knows you have a double-sided document and you’ll see both pages in the Preview XE "Preview"  section.

Gutters are the extra space on the inside of a document left blank, in addition to borders, to account for the space that will be taken up with binding. 

Page Orientation XE "Orientation" 
Go to Page Setup XE "Page Setup" , and choose either Landscape XE "Landscape"  or Portrait XE "Portrait" . The default is Portrait.

This is also the dialog box to use when you’re using a paper size other than 8 ½ by 11”. You can select Envelopes XE "Envelopes" , European A4 size, legal, etc.

Note: you cannot have both portrait and landscape pages in one document, unless you put a Section Break XE "Section Break"  between them. In that case, you would need to print manually.

Paper Source XE "Paper Source" 
This section lets you choose the paper tray to select from when printing. The default values are almost always what you need.

Page Layout

Use this box to set different odd and even Headers and Footers. More on that in the Advanced Word class.

Headers and Footers XE "Headers and Footers" 
Using Headers in Word

To insert a header or footer, you can click View, Headers and Footers. You’ll get a blank space surrounded by a dotted line; this is your header. You will also see the toolbar below: 



Create a Different First Page Header and Footer

How can I make the header and footer different on the first page to the subsequent pages in Word? 

The main controls for this are at File, Page Setup XE "Page Setup" , Layout where you’ll find options for Different First Page and Different Odd/Even.

To setup a header/footer beyond page one (for a currently single page document) you may have to insert a page break temporarily to make a second page. On the second page, choose View | Header and Footer then edit the contents as you wish. You can remove the page break when you have finished—the extra header/footer will be remembered for when they are needed.

The same applies to a document template - open the template, change the page layout options then make a second page.  This will give you access to the subsequent header and footer.  Once you’ve made the changes you can remove the page break from the template.  When you save XE "save"  the template the alternate header/footer will be saved even though they are not visible.  This applies to all versions of Word - though the exact commands may vary slightly.

Useful Features

Quick Forms XE "Forms" : Creating a Questionnaire (Word 95)

How would you like to use Word to create an online questionnaire?  Suppose your organization needs to know the approximate income of each of its active members.

Open a new Word document and type in all the header information. With the sales pitch in place, let’s get to the questions. Type something like this: 

$10,001 - $20,000 

$20,001 - $40,000 

$40,001 - $60,000 

$60,001 - $80,000 

$80,001 - $100,000 

Over $100,000 

Now click the document to the right of $20,000 (maybe add a space and then click). Choose Insert, Form Field XE "Form Field" . When the dialog box opens, select Check Box and click OK. The check box will appear in your document to the right of $20,000. Do the same now for all the numbers. 

To use the questionnaire online, choose Tools, Protect Document. When the Protect Document dialog box opens, select Forms and click OK. Now the only thing anyone can do is select one of the check boxes—they can’t modify the document. 

After someone finishes the questionnaire, you need to save the document. Choose File, Save As and type in a name. Click Save to save the document. You can open the documents that you collect and print them later. 

If you want to mail some of the questionnaires, the check box will show up just fine, so the members can make the selection with a pen and mail it back to you. This is one style of questionnaire to fit all purposes.

Printing Data Only XE "Printing Data Only"  for Forms XE "Forms" 
If you’d like to print only the data from a Word form, you can instruct Word to do this for you. Choose Tools, Options. When the Options dialog box opens, click the Print tab. Select the check box labeled Print Data Only for Forms and click OK. 

The selection remains in effect only for the current document. When you open a new document, the selection will return to the default.

Using AutoText XE "AutoText" 
AutoText is used for frequently used material, and differs from AutoCorrect in that entries can be more than 255 characters long and can include formatting and graphics. Also, you have to specifically insert an AutoText entry before it works. 

To create an AutoText entry, do this:

1. Select the text, graphic, table, or combination of items that you want to add as an AutoText entry.

2. In Word 97, click Insert in the Menu bar, then AutoText, then New. In Word 95 or 6.0, click Edit and AutoText. In either case, a Create AutoText box appears. Word will suggest a name for your entry, but you can change it. An AutoText entry can contain spaces and special characters. If you type a name that is already in use for another entry, Word will warn you. 

3. One hitch: Word will put this entry into all documents you create with the template you are currently using. If you never change templates don’t worry, but if you do, here’s how to put your entry into Normal.dot: In the Look In list box, select either Choose All Active Templates XE "Templates"  or NORMAL.DOT. 

To use an AutoText XE "AutoText"  Entry, do this:

1. Put the Insertion Point where you want the AutoText entry to begin.

2. Text the name you gave the AutoText entry.

3. Press F3 (the Insert AutoText key. The AutoText entry you typed must appear at the beginning of a line or be preceded by a space.

4. If you can’t remember the AutoText abbreviation, do this:

5. Position the Insertion Point where you want the entry

6. Choose Insert, AutoText, and AutoText.
7. Choose the entry you want and click Insert.
Inserting Symbols XE "Inserting Symbols" 
You may need to type special character not found on the keyboard, such as ( ( ( ( ( ( ( ( ( (etc. To insert these and other symbols, do the following:

1. Click where you want the symbol

2. Click Insert in the Menu bar, then Symbol.

3. Select the font which contains the symbol, which will most likely be Symbol, Monotype, or Wingdings.

4. Select the symbol you want; you’ll see a magnified version of that symbol. 

5. Click Insert. Add other symbols in the same way if you wish.

6. Click OK.

Page Numbers XE "Page Numbers" 
Word lets you put a page number anywhere you can put the insertion-point marker: 

1. Position the insertion-point marker anywhere you want a page number to appear (even in a Microsoft Draw XE "Draw"  97 text box). 

2. Press Alt + Shift + P to put in a page number only. Or choose Insert, Page Numbers if you want the option of making more choices. You’ll get this dialog box. Make your choices and click OK.


Hyphenating XE "Hyphenating"  Words

Word has three types of hyphens: optional, regular, and non-breaking. Regular is when a hyphen is inserted to join two words used in combinations, such as non-breaking. A regular hyphen breaks a word, when necessary, so it will wrap at the end of a line. Use a non-breaking hyphen to join words or acronyms you don’t want broken at the end of the line. Optional hyphens break words at the end of a line.

	Hyphen
	Keystroke
	You see
	Function

	Regular
	Hyphen
	-
	Use for words that are always hyphenated and can be split at line breaks.

	Optional
	Ctrl+Hyphen
	
	To split words at the end of a line. Not displayed unless the word appears at the end of the line.

	Non-Breaking
	Shift+Ctrl+ Hyphen
	(
	For words that are always hyphenated and that you don’t want to split at the end of the line.


Creating Labels XE "Labels"  (full page of the same item); Adding a picture XE "picture" 
Choose Tools, Envelopes XE "Envelopes"  and Labels. When the dialog box opens, click Options and then details. Make sure the sizes are correct (label size: 2 inches by 4 inches, 2 across, 5 down) and click OK, and then OK again. Right-click the label text entry box and choose Fonts. Select a font and size and then click OK. 

Now enter the label text. When the text is in place, make sure the Full Page of the Same Label radio button is selected and then click New Document. When the document appears in a standard Word document, click where you want the picture to appear in the first ticket. Let’s assume for this example that you want to use ClipArt XE "ClipArt" . Choose Insert, Object, Microsoft ClipArt Gallery. Choose a picture and click OK. 

Now size the picture and, when it suits you, click the picture to select it. Press Ctrl-C. Next, click in each of the labels where you want the picture to appear and press Ctrl-V. This places the picture in each of the labels. 

To save XE "save"  the document, choose File, Save XE "Save"  As. Name the document, choose a location for it, and click Save. To print the tickets, choose File, Print. When the Print dialog box opens, go to the Number of Copies entry box and type in the number of pages you want to print. If you need 100 items, enter 10 (10 pages with 10 items on each page).  Click OK to begin printing.

Mailing Labels XE "Mailing Labels" : US Postal Service Preferences

The U.S. Postal Service prefers addresses in all caps. They would also rather see you use a sans-serif font (e.g. Arial) with no punctuation (you will need a dash in the Zip + 4 code). And, if you just bought a box of bright green envelopes that you expect to use with white ink, please refrain, the Postal Service much prefers black print on a white background. 

Foreign Currencies XE "Foreign Currencies"  and Characters

Yen XE "Yen"  and Pound Sign XE "Pound Sign" 
A note on using foreign currencies in all Windows applications: 

· To make the symbol for the British Pound, press the alt key and 0163 on the numeric keypad.

· To make the symbol for the Japanese Yen, press the alt key and 0165 on the numeric keypad. ¥ £ (this is 14 point bold.)
· 
(((this is 16 pt. bold, Times New Roman.)
· 
£ ¥  (12 point Garamond Three)
Foreign Accents XE "Foreign Accents" 

 XE "Accents" 

 XE "Accents:Foreign" 
If you do a lot of continental writing, you may need to use special characters—accents, circumflexes, and so on—that make foreign text look foreign. 

· To type a character with an acute accent, press Ctrl +’ (apostrophe) followed by the character. (Resumé)

· To type a character with a grave accent, press Ctrl +` (the apostrophe under the tilde) followed by the character. (è)

· To type a character with a tilde XE "tilde" , press Ctrl + Shift + ~ followed by the character. (ã)

· To type a character with a circumflex XE "circumflex" , press Ctrl + Shift + ^ followed by the character. (ê)

· To type a character with a diaeresis XE "diaeresis" , press Ctrl + Shift + : followed by the character. (ë)

· To create a c with a CEDILLA: Press Ctrl + , (that is, Ctrl + comma). Press c (or Shift + c for an uppercase C).

Special Characters XE "Special Characters"  2 

What I’ve found useful is to change my actual Windows control panel “keyboard” “language properties” setting to “US-International”.  This lets me put special characters in any Windows app, not just Word—including Z-Mail, Notepad, Excel, etc.  

With this method, certain two-key sequences become special characters.  E.g., ‘a becomes à, ‘c becomes ç, ‘e is é, ^i is î, “o is ö.  All this is really helpful when working in Europe, where many place names and street names employ these characters.

The downside is that any time I press the ‘, “, ^, ~, or ‘ keys, Windows “waits” to see what the next character is before doing anything.  To actually type a “, for example, I may have to type “<space>”.  If I’m not careful, a quote that should start with “A word” will end up as Ä word” instead.

This keyboard also supports some Alt key sequences.  Three Swedish/Danish letters that can't be done with two-key sequences:

  Alt+l, Alt-L   ø, Ø

  Alt+w, Alt+W   å, Å

  Alt+z, Alt+Z   æ, Æ

Some others of international interest:

  Alt+shift+4    £

  Alt+- (minus)  ¥

  Alt+1 (one)    ¡

  Alt+/          ¿

  Alt+r, Alt+c   ®, ©

Math XE "Math" 
In-Line Calculations XE "Calculations"  

Here’s another useful way to deal with short calculations in Word. Suppose you’re writing an informal quote or invoice, and you want to show the total cost of a purchase.  You don’t have to grab your calculator or open Excel. All you have to do is tell Word to do the calculation for you. 

Let’s say you sold someone 120 Dingles @ $12.32 each. What’s the total? Type a line like this: 

Thank you for your purchase of 120 Dingles. Please remit $ 

Immediately after the $, press Ctrl-F9 and enter 

=120*12.32 

Now press F9 and the total will appear in the line as shown here: 

Thank you for your purchase of 120 Dingles. Please remit $1478.4 

Add the trailing zero and you’re ready to go.

Use Word to Create a Simple Spreadsheet

If you’re working with a Word document and you have a need for a small spreadsheet, you can create the sheet in Excel and then insert it into the Word document. But, if the spreadsheet requirements are minimal, why not just use Word? 

To create a spreadsheet in a Word document, choose Table, Insert Table. When the Insert Table dialog box opens, choose the number of columns and rows you need for your spreadsheet (you can adjust this later). Now click OK to insert the table. 

View the table just as you would an Excel worksheet, the first cell in the upper left corner is A1. Moving down vertically, you’ll find cells A2, A3, A4, etc. The next column is B1, B2, B3, etc. 

Let’s look at an example now. Let’s say you inserted a table with five columns and four rows. Enter into cell A1 the word Month. Now move down to A2 and enter Jan. Next, go to A3 and enter Feb. In A4, type Total. 

Go to cell B1 and enter a name. In cell B2, enter the sales figure

for January. Enter all figures using a dollar sign ($). Move to B3

and enter sales for February. In cell B4, press Ctrl-F9. Between the

brackets, type 

=sum(b2:b3) 

and then press F9. The sum will appear in cell B4 complete with the dollar sign. If you change any of the numbers, you need to press F9 again to tell Word to perform the calculation. 

Equation Editor XE "Equation Editor"  

Word users need to generate documents that contain equations. This is certainly no problem for Word. Here’s how to add equations to a document. 

As an example, let’s assume that you want to create a document for some young arithmetic students, such as: 

2X=Y+5

You can make this look better if you choose Insert, Object, Microsoft Equation. Now type in the equation, and the Equation editor will put the line into a more pleasing form. 

The real advantage of the Equation editor becomes apparent when you need to enter more complex equations. For example, showing a square root in Word can be cumbersome, but if you use the Equation editor, it will look just as any mathematician would expect it to look.  Because we can’t show you samples, the best approach is to open the Equation editor and experiment with it.

Using Columns XE "Columns" 
For desktop publishers, one of Word's most useful layout features is the ability to create newspaper-style columns of different widths. To achieve this effect, you start by creating a multicolumn layout. Just choose Columns... from the Format menu and select the desired number of columns from the Number of Columns dropdown list. 

By default, Word allots an equal amount of space to each column based on the width of your text area. To vary one or more of these widths, just deselect the Equal Column Width check box. Word will then activate the Width and Spacing text boxes for each column you've created. You can enter the desired measurements in these text boxes and click OK to modify your column widths accordingly.

Creating An Odd Column 

Creating columns in Word is a snap. You just choose Format, Columns.  When the Columns dialog box opens, you can select from one, two, or three columns. You’ll notice that you can also choose a small column at the left or a small column at the right. 

If you like, you can set the column size yourself. All you have to do is deselect Equal Column Width and then set the size of each of your columns. After you finish setting up the columns, click OK to close the dialog box and save XE "save"  your changes.

But remember… if your document has a different number of columns in different locations, you must insert a Section Break XE "Section Break"  between them.

Using Print Preview XE "Print Preview" 
Before you print a document, it’s always a good idea to view it in Print Preview.

Choose File, Print Preview, or click the Print Preview button on the toolbar. You will now see buttons on the top of the window which allow you to do this:

· Print.

· Magnifier: Toggles the mouse pointer between a magnifying glass end the normal mouse pointer (for editing the document). In Word 6.0 you couldn’t make any changes to the document from Print Preview XE "Preview" ; now you can.

· One Page: displays the document in single-page view.

· Multiple pages: displays multiple pages.

· Zoom control: allows you to type in the magnification you want.

· View ruler: Toggles the ruler display on and off.

· Shrink to fit: when the last page of the document contains very little text, it tries to “shrink” the document to fit it on one less page.

· Toggle full Screen view: Toggles between full-screen display (which removes everything but the document and the toolbar) and normal display.

· Close: Returns to your document.

· Context-sensitive Help

Printing XE "Printing" 
To print your document, you can select Print from the file menu, or click on the Print icon on the toolbar, or press Ctrl+P.  If you use Ctrl+P or the Print icon you won’t have any choices, you’ll simply print one copy, to the printer you last used from Word. If you use File in the menu bar, then print, you’ll have these options:

· Choose the printer you want in the box after Name; click Properties for more options on the printer you choose.

· You can print All for the whole document, or the current page, or a range by typing 1-5 after Pages and clicking the Pages button.

· You can print a more than one copy by typing in a number or using the up arrow.

Printing a Draft Copy XE "Draft Copy" 
Word 97’s Draft printing mode is faster than regular printing, because Draft mode prints your document using just one font and minimal formatting. Here’s how it works: 

1.
Choose File + Print to open the Print dialog box. 

2.
Click the Options button. The Options dialog box appears. 

3.
Under Printing Options, select Draft Output. 

4.
Click OK and then click Print. 

The result is a document that’s not suitable for final presentation but is perfect for proofreading. (Be sure to deselect the Draft Printout options before you print your final copy of the document.)

Tips

Don’t Delete XE "Delete"  That Text

When Word starts, it defaults to inserting text rather than typing over existing text. This leads many users to always delete a word or group of words when they really just need to replace them. What we usually do is click where we want to start the new entry, type it in, and then delete the old entry. 

However, if you like, you can click where you want to start replacing text and then press the Insert key so that your new text will simply replace the old text. Don’t forget to press Insert again when you’ve entered the new text.

Special Effects XE "Special Effects"  

Let’s say you want to place a picture in your document. You’d like to create the effect of a portion of a pull quote over part of the picture. The only problem is that by default the text box will hide the picture. 

Go ahead and create a text box and move it over a portion of your picture. Now choose Format, Text Box and click the Colors and Lines tab XE "Colors and Lines tab" . Select the check box labeled Semitransparent and then click OK.  Now the picture will show through the text box, but that portion of the picture under the text box will appear lighter than the uncovered portion.

Using Bookmarks XE "Bookmarks" 
When you work with long documents in Word, you’ll find that’s it’s nice to have some bookmarks to navigate around in the document.  Bookmarks are easy to add, easy to use, and leave no unsightly marks of any kind in your text. And you can put them anywhere at all. 

Click anywhere in your current Word document and then choose Insert, Bookmark. When the dialog box opens, type in a word to use as your bookmark. Now click Add. 

To check your new bookmark, press F5. When the dialog box opens, type in the new bookmark name and then click Go To. Word will deliver you to the bookmarked spot without any further ado.

STYLES XE "STYLES"  

You can format entire paragraphs with two clicks of your mouse. The problem is that the first click is SLOW—you click the little arrow next to the style list, wait for what seems to be most of the day, select your new style, see the change in your paragraph, save XE "save"  your file, and go to bed. 

You can apply some styles much faster with the following keystroke shortcuts (be sure to select the paragraph[s] you want to change first, either by highlighting all the text or placing your insertion point within it): 

· To apply the Normal style, press Ctrl + Shift + N. 

· To apply the Heading 1 style, press Ctrl + Alt + 1. 

· To apply the Heading 2 style, press Ctrl + Alt + 2. 

· To apply the Heading 3 style, press Ctrl + Alt + 3. 

· To apply the List Bullet style, press Ctrl + Shift + L.

STYLES2 

To repeatedly apply a style you just applied:

1. Select the next paragraph to which you want to apply the style. 

2. Press Ctrl + Y. 

It’s an adaptation of the Edit + Repeat shortcut. 

Non-Breaking Space XE "Non-Breaking Space" 
Word wrap is an amazing thing—one of the most basic benefits of word processing. Type a word that’s too long to fit on the current line, and Word automatically moves it to the next line. Sometimes, however, Word’s word wrap separates words you’d rather keep together—such as someone’s first and last name, or the word “Chapter” and the chapter number. No problem; if you want to keep two words together no matter what, link them together with a non-breaking space: 

1.
Type the first word. 

2.
Press Ctrl + Shift + space to insert the non-breaking space. 

3.
Type the second word. 

From now on, these words always appear on the same line. If Word can’t fit the second word on the current line with the first, it moves BOTH words to the next line. 

Q. How do I turn off automatic hyperlinks XE "hyperlinks" ?

A. To turn off automatic hyperlinks, do the following:

1. On the Tools menu, click AutoCorrect XE "AutoCorrect" , and then click the AutoFormat tab.

2. Click to clear the “Internet and network paths with hyperlinks” check box.

3. Click OK.

Printing XE "Printing"  from Two Trays 

If you’re trying to get your printer to print the first page of a document on your letterhead—placed in one tray—and the rest of your document on regular paper, stored in another tray, try this: 

1.
Load one of your printer’s paper trays with your letterhead and the other with regular paper. (NOTE: As you’ve probably determined by now, if your printer doesn’t have two paper trays XE "paper trays" , you can’t use this procedure). 

2.
Choose File + Page Setup. 

3.
In the Page Setup XE "Page Setup"  dialog box, click the Paper Source XE "Paper Source"  tab. 

4.
Under First Page, select the tray containing your letterhead. 

5.
Under Other Pages, select the tray containing your regular paper. 

6.
Click OK. 

When you print this document, Word automatically takes the first page of your document from the letterhead tray XE "letterhead tray"  and the remaining pages from the regular tray. 

A Page Of Its Own 

Some paragraphs—chapter titles, introductions, the first paragraph in the story of your life—deserve more attention than others. You don’t want paragraphs like these appearing in the middle of some page, surrounded by other lesser paragraphs. To ensure that a paragraph ALWAYS begins at the top of a brand-new page, no matter how you edit the paragraph or the text around it, follow these steps: 

1.
Right-click anywhere within the paragraph you want to appear at the top of a page. 

2.
From the shortcut menu, choose Paragraph to open the Paragraph dialog box. 

3.
Click the Lines and Page Breaks tab. 

4.
Under Pagination, select Page Break Before. 

5. Click OK.

When Is An Underline XE "Underline"  Not An Underline 

When it’s something more, of course. Did you know that you could double-underline text? Or  underline it with a thicker line? Dashes and/or dots? A wavy line? You can. Here’s how: 

1.
Select the text you want to underline. 

2.
Right-click the selection and choose Font. 

3.
In the Underline drop-down list of the Font dialog box, choose the type of underlining you want (you can see the results in the preview box before you finalize your selection). 

4. Click OK. 

What Word components do you have installed XE "installed" 

 XE "installed:components" ?

Have you ever been baffled by the apparent absence of some feature or element in your Word program? For example, you might have heard a co-worker describe wizards you don’t seem to have, or maybe you can’t access Visual Basic Help. If this is the case, odds are you have a Typical installation of Word on your machine. Word Setup’s Typical option doesn’t install certain Word components that are considered less critical for normal Word use (such as some extra wizards, Visual Basic Help, and various file converters). Luckily, you can always rerun Setup and add any missing features you need later on.

If you’d like to know exactly which items are included in a typical installation, Word help can enlighten you. All you have to do is choose Microsoft Word Help from the Help menu, type installed with Word, and click Search. Then, select the first topic, What’s Installed with Word 97. This will bring up a help window listing all the components the Typical option installs—so you can see which features you might be missing.

The Largest font size XE "font size"  Word 97 can handle? 

The answer is 1638 points—or 136.5 inches.

Put A Border XE "Border"  around It 

Word 97 allows you to apply a border to an entire page. If you need to make a decorative page for your organization, perhaps you’d like to use a page border. Word includes some artwork for your border. 

Let’s say you want to write a letter to some fellow animal lovers—so a border of cats would look nice. Choose Format, Borders and Shading.  When the Borders and Shading dialog box opens, click the Page Border tab. Now locate the list box labeled Art and click the arrow at the right side of the list box to expand the list. Select the artwork you want to use (in this case, the cats) and then click OK to close the dialog box and record your selections. 

Word will now automatically switch to Page Layout XE "Page Layout"  view (unless you’re already there), and your border selection will appear.

Making A Blank Line XE "Blank Line" 
When you choose to use bullets XE "bullets"  or numbering in a Word document the new number or bullet appears when you press Enter. If you’d like to insert a blank line between one bulleted line and another, you can press Shift-Enter. To get to the next bulleted line, press Enter.  This produces the effect shown here. 

1.
Line one 

2.
Line two 

3.
Line three 


4.
Line four 

5. Line five

Automated Envelopes XE "Automated Envelopes" 

 XE "Envelopes"  

You may already be familiar with Word 97’s Envelope feature: Just choose Tools + Envelopes XE "Envelopes"  and Labels, and Word guides you as you address and print an envelope. It even tells you how to feed the envelope into your printer. Well, as automatic as all this seems, there is one way you can make the process even more automatic: 

1.
In your letter, select your recipient’s name and address. 

2. THEN choose Tools + Envelopes XE "Envelopes"  and Labels. When the Envelopes and Labels dialog box opens, there’s your recipient’s address, right where it belongs (in the Deliver Address box), which means you don’t have to type it a second time. 

Delete It Now

There are times when you choose File, Open in a Microsoft Office document and just happen to notice a file that needs deleting. You don’t have to wait until you finish what you’re doing and then use Windows Explorer to delete the file. All you have to do is select the file in the Open window and then press Delete XE "Delete" . This will delete the file and you can go ahead with your work.

Set Your Open Dialog Box

When you choose File, Open, Word displays the files that you can open using Word. You have quite a bit to say about how those files appear.  For example, if you’d like to see all the dates of creation and file sizes, you can click the Details button in the toolbar (it looks like a small page of text). 

You can also tell Word that you’d like to see a preview of the text in the selected file. To do this, click the Preview XE "Preview"  button (it looks like a bulleted list on white paper). With this selection in effect, any selected file will be displayed in the preview pane. 

If you’d like to see the properties of selected files, click the Properties button (just to the right of the Details button).

Sorting XE "Sorting"  in Open Dialog Box

What do you do if you want to change the way the dialog box sorts the files? 

Look at the bar above the file list (in Details view). You’ll see Name, Size, Type, and Modified. To sort by name (the default), click Name. If you would rather sort by size, click Size. 

When you click an object, Word will sort in ascending order by the selected property. If you’d like to sort by the date, click Modified.  Now your files will appear in order of the last date they were modified.

Using Tab Leaders XE "Leaders" 

 XE "Tab Leaders" : Creating Lines

Tab Leaders are characters leading up to some text, like this: 

......Text Leaders. 

They can be lines, dots, dashes, and the advantage of using them is that you can set them up so that they will end exactly where you want them to, depending on where your tab is.

Choose Format, Tabs. When the dialog box opens, enter the tab position you want to use (in inches). Now look under Leader. Select the radio button associated with the type of leader you want and then click Set. Now click OK to record your selection and close the dialog box. Now when you use the Tab key, the tab location you entered will display the leader. This one is 6.5”, right-justify, solid line.

Sidebars XE "Sidebars"  and Pull Quotes XE "Pull Quotes"  

When you produce a newsletter using Word, you might want to make it look more professional by making use of sidebars and pull quotes. A sidebar is a great way to expand on a particular topic in your main article. A pull quote is a good way to draw attention to an important point in your article and grab the reader’s interest. The sidebar can appear anywhere in the article, but a pull quote is usually on the page where the quote appears and usually on the first page of an article. 

To produce either a sidebar or a pull quote, choose Insert, Text Box XE "Text Box" .  Word will switch to Page Layout view. Now draw the box using the mouse. Don’t worry about size and position right now; you can change both later. 

Now enter the desired text into the text box. Click the text box to select it and then choose Format, Text Box XE "Text Box" . When the Format Text Box dialog box opens, click the Wrapping tab. Select the type of wrapping you’d like to use and click OK. Now you can use the mouse to drag the box into position and to set the final size.

Selecting Part of a Word, Paragraph or Page

The question is, how do you select a block of text from a document?  That is, select a block of text without regard to sentences, paragraphs, or page breaks. The answer is, you hold down the Alt key while using the mouse to select a portion of the document. 

Using Split Screen XE "Split Screen" 
The Split command (in the Windows menu in the Windows bar) lets you split the Word display to show one part of the document in one window and another part in the other window, saving you lots of scrolling, especially when you’re working with long documents. But then, when your work is done, you unsplit the display and Word closes the wrong part of the split screen, forcing you to scroll to wherever it is you wanted to be. 

How can you prevent this frustrating, recurring fate? It’s easy, really. Before you unsplit a split display, do the following: 

1.
Click to position the insertion point in the pane where you want to begin working AFTER you unsplit. 

2.
Then unsplit the display (by choosing Window + Remove Split). 

Word keeps the active pane (the one in which you clicked) open, and closes the other one.
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